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Chapter 1. Setup

The goal of this chapter of the tutorial isto install (or check that you already have installed) a minimally needed
set of software to build a Cayenne application.

1.1. Install Java

Obvioudly, JDK hasto be installed. Cayenne 3.1 requires JDK 1.5 or newer.

1.2. Install Eclipse IDE and the Maven Plugin

Download Eclipse. This tutoria is based on the Galileo package (Eclipse 3.5), JEE edition, still it should work
with any recent vanilla Eclipse distribution.

After downloading Eclipse, unpack it somewhere in thefilesystem, and start it. The only plugin that you need for
thetutorial ism2eclipse. Toinstall it, in Eclipse go to "Help > Install New Software”, then click on"Add.." to add
anew download site, and enter "Maven" in the "Name" field, and "http://m2eclipse.sonatype.org/sites/m2e” in
the "Location" field. Y ou may install any of the optional components that you think you need, but for thistutorial
we only select afew basic components as shown on the following screenshot:
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Available Software
Check the iterns that you wish to install.

Work with: |http:,.ffm2ec|ipse.sonatype,orgfsites,fmze H (_ Add... )

Find more software by working with the “Available Software Sites” preferences.

I,r'o_.rpe filter text \l
|Name |\-'ersiur| |

# ¥ 000 Maven Integration for Eclipse

™ L4 Maven Integration for Eclipse (Required) 0.12.1.20110112-1712

( selectall ) [ Deselectall ) 1 item selected

Details
E Show only the latest versions of available software [] Hide items that are already installed
E Group items by category What is already installed?

E Contact all update sites during install to find required software

From
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here follow the Eclipse dialog instructions to finish the installation.
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Chapter 2. Starting a project

The goal of this chapter isto create anew Java project in Eclipse containing abasic Cayenne mapping. It presents
an introduction to CayenneModeler GUI tool, showing how to create the initial mapping objects. DataDomain,
DataNode, DataM ap.

2.1. Create a new Project in Eclipse

In Eclipse select "File > New > Other..." and then "Maven > Maven Project”. Click "Next". On the following
screen check "Create a simple project” checkbox and click "Next" again. In the dialog shown on the screenshot
below, fill the "Group Id" and "Artifact Id" fields and click "Finish".

(< TN MNew Maven Project

New Maven project -,
Configure project M
Artifact
Croup Id: org.example.cayenne E]

Artifact Id: | tutorial

| «

Version: | 0.0.1-SNAPSHOT B

Packaging: .jar Z]

Mame: [ E]
Description:

Parent Project

Croup Id: E]
Artifact Id: -
Version: [ Z] [ Browse... | Clear

b Advanced
/ah_ N P \ r % I{ .. h ‘\,I
|u_)| L < Back 3L Mext = ] L Cancel ¥ Finis

A
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Starting a project

Now you should have anew empty project in the Eclipse workspace. Check that the project Javacompiler settings
are correct. Rightclick on the "tutorial” project, select "Properties > Java Compiler" and ensure that "Compiler
compliance level" is at least "1.5" (some versions of Maven plugin seem to be setting it to 1.4 by default).

2.2. Download and Start CayenneModeler

Although later in thistutorial we'll be using Maven to include Cayenne runtimejarsin the project, you'll still need
to download Cayenne to get access to the CayenneModel er tool.

Note

If you are redly into Maven, you can start CayenneModeler from Maven too. Well do it in a more
traditional way here.

Download the latest release. Unpack the distribution somewhere in the file system and start CayenneModeler,
following platform-specific instructions. On most platformsit isdone simply by doubleclicking the Model er icon.
The welcome screen of the Modeler looks like this:

[EEL

Recent Projects:

B £

New Project Open Project
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Starting a project

2.3. Create a New Mapping Project in CayenneModeler

Click on the "New Project" button on Welcome screen. A new mapping project will appear that containsasingle
DataDomain. The meaning of a DataDomain is explained elsewhere in the User Guide. For now it is sufficient
to understand that DataDomain is the root of your mapping project.

2.4. Create a DataNode

The next project object you will create is a DataNode. DataNode is a descriptor of a single database your
application will connect to. Cayenne mapping project can use more than one database, but for now, well only
use one. With "project” selected on the left, click on "Create DataNode" button on the toolbar (or select "Project
> Create DataNode" from the menu.

A new DataNode is displayed. Now you need to specify JDBC connection parameters. For an in-memory Derby
database you can enter the following settings:

e JDBC Driver: org.apache.derby.jdbc.EmbeddedDriver

» DB URL: jdbc:derby:memory:testdb;create=true

Note

We are creating an in-memory database here. So when you stop your application, al the datawill belost.
In most real-life cases you'll be connecting to a database that actually persistsits data on disk, but an in-
memory DB will do for the smple tutorial.

Also you will need to change "Schema Update Strategy". Select
"org.apache.cayenne.access.dbsync.Createl fNoSchemaStrategy" from the dropdown, so that Cayenne creates a
new schema on Derby based on the ORM mapping when the application starts.
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Starting a project

s NN &) * - CayenneModeler - [New]
Cle[@] =] [+</mla [¢]v] [6]»] (E[E [e[e]a] [c][=] Search:
8 project [ Main | Adapter  Password Encoder !
B atanoce

DataMode Configuration

DataMode Name:

Schema Update Strategy:

Local DataSource (opt.):

DataSource Factory:

JDBC Configuration

JDBC Driver:

DB URL:

datanode

apache.cayenne.access.dbsync.SkipSchemaUpdateStrategy ﬂ

You can enter custom class implementing SchemaUpdateStrategy

RS,

[ Select DataSource for Local Work...

ayenne.configuration.server. XMLPoolingDataSourceFactory j

org.apache.derby.jdbc.EmbeddedDriver

jdbec:derby:memory:testdb;create=true

Username:

Password:

Min Connections:

Max Connections:

It : Y
[ Sync with Local |

2.5. Create a DataMap

Now you will create aDataM ap. DataMap is an object that holds all the mapping information. To create it, click
on "Create DataMap" button (or select a corresponding menu item). Note that the newly created DataMap is
automatically linked to the DataNode that you created in the previous step. If there is more than one DataNode,
you may need to link a DataMap to the correct node manually. In other words a DataMap within DataDomain

must point to a database described by the map.

You

can leave Al

the DataMap defaults unchanged except for one -

"org.example.cayenne.persistent”. This name will later be used for all persistent classes.

v.3.1
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Starting a project

s NN &) * - CayenneModeler - [New]
| EeE (%] [#[R e[| [o]a] [EHE [ [E]=] Search:
& project DataMap
"

> © datanode DataMap Configuration

DataMap Mame: datamap
File: (no file)
DataNode: | & datanode ,-]

Quote SOL Identifiers: [ |

Entity Defaults

DB Schema: Update...

. Java Package: org.example.cayenne.persistent ] Update...

Custom Superclass: Update...
Optimistic Locking: [ ]

Client Class Defaults
Allow Client Entities: [

Client Java Package: Update...

Custom Superclass: Update...

2.6. Save the Project

Before you proceed with the actual mapping, let's save the project. Click on "Save" button in the toolbar and
navigate to the "tutorial" Eclipse project folder that was created earlier in this section and its " src/main/resources’
subfolder and save the project there. Now go back to Eclipse, right click on "tutorial™ project and select "Refresh”,
you will see three Cayenne XML files.
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Starting a project

TE_;—';'-tutnrial
P #src/main/java
|X| cayenne-project.xmil
|X| datamap.map.xml
b B src/test/java
b [ src/test/resources
b = JRE Systemn Library [J25E-1.5]
"-'ﬁ, Mawven Dependencies
P = srC
b (= target
E] pom.xmi

Note that the location of the XML files is not coincidental. Cayenne runtime looks for "cayenne-* .xml" filein
the application CLASSPATH and "src/main/resources’ folder should already be a "class folder" in Eclipse for
our project (and is also a standard location that Maven would copy to ajar file, if we were using Maven from

command-line).

v.3.1
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Chapter 3. Getting started with Object
Relational Mapping (ORM)

The goal of this section is to learn how to create a simple Object-Relational model with CayenneModeler. We
will create a complete ORM model for the following database schema:

ARTIST

ID INTEGER (PK)
NAME VARCHAR(200)
DATE_OF_BIRTH DATE

1

PAINTING n

ID INTEGER (PK)

NAME VARCHAR(200)
ARTIST_ID INTEGER (FK)
GALLERY _ID INTEGER (FK)

i

GALLERY 1

ID INTEGER (PK)
NAME VARCHAR(200)

Note

Very often you'd have an existing database already, and it can be quickly imported in Cayennevia"Tools
> Reengineer Database Schema. Thiswill save you lots of time compared to manual mapping. However
understanding how to create the mapping by hand isimportant, so we are showing the "manual" approach
below.

3.1. Mapping Database Tables and Columns

Lets go back to CayenneM odeler where we have the newly created project open and start by adding the ARTIST
table. Databasetablesarecaled " DbEntities" in Cayenne mapping (those can be actual tables or database views).

Select "datamap” on the left-hand side project tree and click "Create DbEntity" button (or use "Project > Create
DbEntity" menu). A new DbEntity is created. In "DbEntity Name" field enter "ARTIST". Then click on "Create
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Getting started with Object Relational Mapping (ORM)

Attribute”" button on the entity toolbar (third button from the left). This action changes the view to the " Attribute"
tab and adds a new attribute (attribute means a "table column” in this case) called "untitledAttr". Let's rename it
to ID, makeit an INTEGER and makeit aPK:

amno * - CayenneModeler — fUsers/dzmitry/tutorial/src/main/resources/cayenne-project.xml
EE*%C”,B%D@@O\CDCD Search:
8 project [ Entity - Attributes | Relationships 1
v o datamap = :
a]ARTIST | GlE g [t :
» [ datanode Name ¥ Type PK Mandatory |Max Length|  Scale
N = T N N I

Similarly add NAME VARCHAR(200) and DATE_OF BIRTH DATE attributes. After that repeat this procedure
for PAINTING and GALLERY entities to match DB schema shown above.

Note

Don't forget to save your project periodicaly to avoid losing your work. You will also have to refresh
the project in Eclipse after every CayenneModeler save, as Eclipseis by default unaware of any changes
made in the Modeler.

3.2. Mapping Database Relationships

Now we need to specify relationships between ARTIST, PAINTING and GALLERY tables. Start by creating a
one-to-many ARTIST/PAINTING relationship:

» Select the ARTIST DbEntity on the left and click on the "Relationships’ tab.

« Click on"Create Relationship™" button on the entity toolbar (second button from the I eft) - arelationship called
"untitledRel" is created.

* Choose the "Target" to be "Painting".

* Click on the "Database Mapping" button (letter "I" in acircle) - relationship configuration dialog is presented.
Here you can assign aname to the relationship and also its complimentary reverse relationship. This name can
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Getting started with Object Relational Mapping (ORM)

be anything (thisisreally asymbolic name of the database referential constraint), but it is recommended to use
avalid Java identifier, as this will save some typing later. Well call the relationship "paintings’ and reverse
relationship "artist".

e Click on"Add" button on the right to add ajoin
e Select "ID" column for the "Source" and "ARTIST _ID" column for the target.

 Relationship information should now look like this:

806 DbRelationship Info: ARTIST to PAINTING

DbRelationship Information

Relationship: paintings

Reverse Relationship | artist|

Joins

Source ¥ | Target ( Add )
—_—

[ Remove |
. R

£ A [ b |
L Done ) C Cancel )

* Click "Done" to confirm the changes and close the dial og.

» Two complimentary relationships have been created - from ARTIST to PAINTING and back. Still you may
have noticed one thing is missing - "paintings" relationship should be to-many, but "To Many" checkbox is
not checked. Let's change that - check the checkbox for "paintings' relationship, and then click on PAINTING
DbEntity, and uncheck "artist” relationship " To Many" to makethereverserelationship "to-one" asit should be.

* Repesat the steps above to create a many-to-one relationship from PAINTING to GALLERY, calling the
relationships pair "gallery" and "paintings’.

v.3.1 13



Getting started with Object Relational Mapping (ORM)

3.3. Mapping Java Classes

Now that the database schema mapping is complete, CayenneModeler can create mappings of Java classes (aka
"ObjEntities") by deriving everything from DbEntities. At present thereisno way to do it for the entire DataM ap
inone click, so we'll doit for each table individually.

« Select "ARTIST" DbEntity and click on "Create ObjEntity" button (a green class icon) either on the entity
toolbar or on the main toolbar. An ObjEntity called "Artist" is created with a Java class field set to
"org.example.cayenne.persistent. Artist”. The modeler transformed the database names to the Java-friendly
names (e.g., if you click on the "Attributes’ tab, you'll see that "DATE_OF BIRTH" column was converted
to "dateOfBirth" Java class attribute).

e Select "GALLERY" DbEntity and click on "Create ObjEntity" button again - you'll see a"Gallery" ObjEntity
created.

* Finaly, do the same thing for "PAINTING".

Now you need to synchronize relationships. Artist and Gallery entities were created when there was no related
"Painting" entity, so their relationships were not set.

¢ Click onthe"Artist" ObjEntity and (optinally) changeto the"Relationships' tab. Now click on " Sync ObjEntity
with DbEntity" button on the toolbar (two yellow arrows) - you will see the "paintings' relationship appear.

¢ Do the samefor the "Gallery" entity.

Unless you want to customize the Java class and property names (which you can do easily) the mapping is
complete.
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Chapter 4. Creating Java Classes

Here we'll generate the Java classes from the model that was created in the previous section. CayenneModeler
can be used to aso generate the database schema, but since we specified "Createl INoSchemaStrategy"” earlier
when we created a DataNode, we'll skip the database schema step. Still be aware that you can do it if you need
to via"Tools > Create Database Schema'.

4.1. Creating Java Classes

» Select "Tools > Generate Classes" menu.
e For "Type" select "Standard Persistent Objects”, if it is not already selected.

« For the "Output Directory" select "src/main/java’ folder under your Eclipse project folder (thisis a "peer”
location to the cayenne-* .xml location we selected before).

« Click on "Entities' tab and check the "Check All Classes' checkbox (unlessit is already checked and reads
"Uncheck all Classes").

¢ Click "Generate"

Now go back to Eclipse, right click on "tutorial™ project and select "Refresh” - you should see pairs of classes
generated for each mapped entity. Y ou probably also see that there's a bunch of red sgquiggles next to the newly
generated Java classesin Eclipse. Thisis because our project does not include Cayenne as a Maven dependency
yet. Let'sfix it now by adding "cayenne-server" artifact in the bottom of the pom.xml file. The resulting POM
should look like this:

<project xm ns="http://maven. apache. org/ POM 4. 0. 0" xm ns: xsi ="htt p://ww. w3. or g/ 2001/ XM_Schema- i nst ance"

xsi : schemaLocati on="http:// maven. apache. org/ POM 4. 0. 0 http:// maven. apache. or g/ maven-v4_0_0. xsd" >
<nodel Ver si on>4. 0. 0</ nodel Ver si on>

<gr oupl d>or g. exanpl e. cayenne</ gr oupl d>
<artifactld>tutorial </artifactld>
<ver si on>0. 0. 1- SNAPSHOT</ ver si on>

<dependenci es>
<dependency>
<gr oupl d>or g. apache. cayenne</ gr oupl d>
<artifactld>cayenne-server</artifactld>
<I-- Here specify the version of Cayenne you are actually using -->
<versi on>3. 1M3</ ver si on>
</ dependency>
</ dependenci es>
</ proj ect >

Y our computer must be connected to the internet. Once you save the pom.xml, Eclipse will download the needed
Cayenne jar file and add it to the project build path. Asaresult, al the errors should disappear.
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Creating Java Classes

B ek 5 & v =" m—m _Galleryjava | [J] _Datamap.java
?:';‘Jtutnrial package org.exomple.cayenne.persistent.auto;
¥ i # src/main/java ) _ )
¥ I8 org.example.cayenne.persistent @ import java.util.Date;[]
Imﬁ.rtlst.Ja'-.ra_ — en
> [J] patamap java * (lass _Artist was generaoted by Cayenne.
» iJ] Gallery java * Tt is probably a good idea to avoid chamging -
b L) Painting.java * zince 1t maoy be overwritten next time code 1is
?J':-Bnrg.example.cavenne.persistent.autn * Tf you need to make any customizations, pleas
L g m _Artist.java */
» [J] _Datamap.java Wi public abstract class _Artist extends CayenneDat
:%f;'ﬁ:;jza public static final String DATE_OF_BIRTH_PRO
- public static final String NAME_PROPERTY = ™i
¥ (& src/main/resources public static final String PAINTINGS_PROPERT
|X| cayenne-praoject.xmil
|¥| datamap.map.xml public static final String ID PK_COLUMN = "I|
P & sro/test/java
b [ src/test/resources = public void setDateO0fBirth(Date dateOfBirth}
b = JRE System Library [J256-1.5] , writeProperty("date0fEirth", dotelfEirth
¥ B, Maven Dependencies . .
!Flhlﬁi cayenn:sewer—S 1M3.jar - fUsers/dzmil B public Date getDateOfBirth() { B
= ‘ § ! ! return (DatelreadProperty("datedfBirth"}
P oo commons-collections-3. 1L.jar - /Users/dz }
L g @ commons-logging-1.1.jar - /Users /dzmil
P g velocity-1.6.3.jar - [Users/dzmitry/.m2 /1 = public void setMame(5tring naome) {
3 @ commons-lang-2.4.jar - [Users/dzmitry/ writeProperty("name", namel;
b (o oro=2.0.8.jar - fUsers/dzmitry/.mZ frepo: }
'B;c = public S5tring gl_ethlame() {
b = target return (String)readProperty("nome"’);
" 1
M| pom.xml

Now let's check the entity class pairs. Each one is made of a superclass (e.g. Artist) and a subclass (e.g.
Artist). You should not modify the superclasses whose names start with " " (underscore), as they will
be replaced on subsequent generator runs. Instead all custom logic should be placed in the subclasses in
"org.example.cayenne.persistent” package - those will never be overwritten by the class generator.

Note

Class Generation Hint Often you'd start by generating classes from the Modeler, but at the later stages
of the project the generation is usually automated either via Ant cgen task or Maven cgen mojo. All three
methods are interchangeable, however Ant and Maven methods would ensure that you never forget to
regenerate classes on mapping changes, as they are integrated into the build cycle.
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Chapter 5. Getting started with
ObjectContext

In this section we'll write a simple main class to run our application, and get a brief introduction to Cayenne
ObjectContext.

5.1. Creating the Main Class

* In Eclipse create anew class called "Main" in the "org.example.cayenne”" package.

* Create astandard "main" method to make it arunnable class:
package org. exanpl e. cayenne;
public class Main {
public static void main(String[] args) {

}

« Thefirst thing you need to be abl e to accessthe databaseisto create a ServerRuntime object (whichisessentialy
awrapper around Cayenne stack) and use it to obtain an instance of an ObjectContext.

package org. exanpl e. cayenne;

i mport org.apache. cayenne. Qbj ect Cont ext ;
i mport org.apache. cayenne. confi guration. server. Server Runti ne;

public class Main {

public static void main(String[] args) {
Server Runti ne cayenneRunti me = new Server Runti me(
"cayenne-project.xm");
bj ect Cont ext cont ext = cayenneRunti ne. get Cont ext ();

ObjectContext is an isolated "session" in Cayenne that provides all needed APl to work with data
ObjectContext has methods to execute queries and manage persistent objects. We'll discuss them in the
following sections. When the first ObjectContext is created in the application, Cayenne loads XML mapping
files and creates a shared access stack that islater reused by other ObjectContexts.
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Getting started with ObjectContext

5.2. Running Application

L et's check what happenswhen you run the application. But before we do that we need to add another dependency
to the pom.xml - Apache Derby, our embedded database engine. The following piece of XML needs to be added
to the <dependencies>...</dependencies> section, where we already have Cayenne jars:

<dependency>
<gr oupl d>or g. apache. der by</ gr oupl d>
<artifactld>derby</artifactld>
<ver si on>10. 8. 1. 2</ ver si on>

</ dependency>

Now we are ready to run. Right click the "Main" classin Eclipse and select "Run As > Java Application”. In the
console you'll see output similar to this, indicating that Cayenne stack has been started:

I NFO Loading XML configuration resource fromfile:cayenne-project.xn
I NFO. | oadi ng user nane and password.
I NFO Created connection pool: jdbc:derby: menory:testdb;create=true
Driver class: org.apache. derby.jdbc. EnbeddedDri ver
M n. connections in the pool: 1
Max. connections in the pool: 1

Note

How to Configur e Cayenne L ogging. Follow the instructions in the logging chapter to tweak verbosity
of the logging outpui.
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Chapter 6. Getting started with persistent
objects

In this chapter wel'll learn about persi stent objects, how to customize them and how to create and save them in DB.

6.1. Inspecting and Customizing Persistent Objects

Persistent classes in Cayenne implement a DataObject interface. If you inspect any of the classes generated
earlier in this tutorial (e.g. org.example.cayenne.persistent.Artist), you'll see that it extends a class with the
name that starts with underscore (org.example.cayenne.persistent.auto._Artist), which in turn extends from
org.apache.cayenne.CayenneDataObject. Splitting each persistent class into user-customizable subclass (Xyz)
and a generated superclass (_Xyz) is a useful technique to avoid overwriting the custom code when refreshing
classes from the mapping model.

Let'sfor instance add a utility method to the Artist class that sets Artist date of birth, taking a string argument for
the date. It will be preserved even if the model changes later:

package org. exanpl e. cayenne. persi stent;

i nport java.text.ParseException;
i nport java.text.Sinpl eDat eFor nat ;
i nport java.util.Date;

i mport org. exanpl e. cayenne. persi stent.auto. _Artist;

public class Artist extends _Artist {

v.3.1

static final String DEFAULT_DATE_FORMAT = "yyyyMwdd";

/**
* Sets date of birth using a string in format yyyyMwid.
*/
public void setDateOBirthString(String yearMnthDay) {
if (yearMonthDay == null) {
setDateOfBirth(null);
} else {

Dat e date;
try {
date = new Si npl eDat eFor mat ( DEFAULT_DATE_FORNVAT)
. par se(year Mont hDay) ;
} catch (ParseException e) {
throw new ||| egal Argunment Excepti on(
"A date argument nust be in format '"

+ DEFAULT_DATE_FORMAT + "': " + year Mont hDay);

}

set DateOf Bi rt h(date);

20



Getting started with persistent objects

6.2. Create New Objects

Now well create a bunch of objects and save them to the database. An object is created and registered with
ObjectContext using "newObject” method. Objects must be registered with DataContext to be persisted and to

allow setting relationships with other objects. Add this code to the "main” method of the Main class:

Artist picasso = context.new(bject(Artist.class);
pi casso. set Nane( " Pabl o Pi casso");
pi casso. setDateO'BirthString("18811025");

Note that at this point "picasso" object is only stored in memory and is not saved in the database. Let's continue

by adding a Metropolitan Museum "Gallery" object and afew Picasso "Paintings":

Gal l ery metropolitan = context.newbject(Gallery.class);
nmet ropol i t an. set Nane(" Metropol i tan Museum of Art");

Painting girl = context.newlbj ect (Painting.class);
girl.setNane("Grl Reading at a Table");

Pai nting stein = context.newdbj ect (Painting.class);
stein.set Name("Gertrude Stein");

Now we can link the objects together, establishing relationships. Note that in each case below relationships are
automatically estabdlished in both directions (e.g. picasso.addToPaintings(girl) has exactly the same effect as

girl.setToArtist(picasso)).

pi casso. addToPai ntings(girl);
pi casso. addToPai nti ngs(stein);

girl.setGllery(netropolitan);
stein.setGallery(nmetropolitan);

Now lets save al five new objects, in asingle method call:

cont ext . conmi t Changes() ;

Now you can run the application again as described in the previous chapter. The new output will show a few

actual DB operations:

or g. apache. cayenne. confi gurati on. XM_Dat aChannel Descri pt or Loader | oad
I NFO Loading XM_ configuration resource fromfile:cayenne-project.xmn

I NFO Openi ng connection: jdbc:derby: menory: testdb;create=true
Logi n: null
Passwor d: *x*****
I NFO +++ Connecti ng: SUCCESS.
INFO Detected and installed adapter: org.apache. cayenne. dba. der by. Der byAdapt er
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INFO --- transaction started.
INFO No schenma detected, will create napped tables
I NFO CREATE TABLE GALLERY (1D I NTEGER NOT NULL, NAME VARCHAR (200), PRI MARY KEY (ID))

I NFO CREATE TABLE ARTI ST (DATE_OF_BI RTH DATE, |D I NTEGER NOT NULL, NAME VARCHAR (200), PRI MARY KEY (1D))

I NFO CREATE TABLE PAI NTI NG (ARTI ST_I D | NTEGER, GALLERY_I D | NTEGER, |D | NTEGER NOT NULL,
NAME VARCHAR (200), PRI MARY KEY (1D))
INFO ALTER TABLE PAI NTI NG ADD FOREl GN KEY (ARTI ST | D) REFERENCES ARTI ST (I D)
INFO ALTER TABLE PAI NTI NG ADD FOREl GN KEY (GALLERY_| D) REFERENCES GALLERY (I D)
I NFO. CREATE TABLE AUTO PK_SUPPORT (
TABLE_NAME CHAR(100) NOT NULL, NEXT_ID BIG NT NOT NULL, PRI MARY KEY( TABLE NAME))
INFO DELETE FROM AUTO PK_SUPPORT WHERE TABLE_NANE I N (' ARTIST', ' GALLERY', ' PAI NTING )
INFO. | NSERT | NTO AUTO PK_SUPPORT ( TABLE NAMVE, NEXT_|D) VALUES (' ARTIST', 200)
INFO. | NSERT | NTO AUTO PK_SUPPORT ( TABLE_NAME, NEXT_ID) VALUES (' GALLERY', 200)
INFO. | NSERT | NTO AUTO PK_SUPPORT ( TABLE_NAME, NEXT | D) VALUES (' PAINTING , 200)
INFO. SELECT NEXT_| D FROM AUTO PK_SUPPORT WHERE TABLE NAME = ? FOR UPDATE [bind: 1:'ARTIST ]
INFO. SELECT NEXT_| D FROM AUTO PK_SUPPORT WHERE TABLE NAME = ? FOR UPDATE [bind: 1:' GALLERY' ]

I NFO SELECT NEXT_I D FROM AUTO_PK_SUPPORT WHERE TABLE_NAME = ? FOR UPDATE [bi nd: 1:'PAINTING ]

I NFO | NSERT | NTO GALLERY (1D, NAME) VALUES (?, ?)

INFO [batch bind: 1->ID:200, 2->NAME:' Metropolitan Miseum of Art']
I NFO === updated 1 row.

I NFO. | NSERT | NTO ARTI ST (DATE_OF BIRTH, ID, NAVE) VALUES (?, ?, ?)

INFQ [batch bind: 1->DATE_OF_BI RTH: ' 1881-10-25 00: 00: 00. 0', 2->|D: 200, 3->NAME:' Pabl o Pi casso']

I NFO. === updated 1 row.
I NFO | NSERT | NTO PAINTING (ARTIST_I D, GALLERY_ID, ID, NAME) VALUES (?, ?, 2, ?)
INFO [batch bind: 1->ARTIST | D: 200, 2->GALLERY_ID: 200, 3->1D: 200, 4->NAME:' Gertrude Stein']

INFO: [batch bind: 1->ARTIST_ID: 200, 2->GALLERY_I D: 200, 3->ID: 201, 4->NAME:'Grl Reading at a Table'

INFO. === updated 2 rows.
I NFO +++ transaction comitted.

So first Cayenne creates the needed tables (remember, we used "CreatelfNoSchemaStrategy™). Then it runs a

number of inserts, generating primary keys on the fly. Not bad for just afew lines of code.
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This chapter shows how to select objects from the database using SelectQuery.

7.1. Introducing SelectQuery

It was shown before how to persist new objects. Cayenne queries are used to access aready saved objects. The
primary guery type used for selecting objects is SelectQuery. It can be mapped in CayenneModeler or created
viathe API. WEe'll use the later approach in this section. We don't have too much data in the database yet, but we
can still demonstrate the main principles below.

» Select all paintings (the code, and the log output it generates):

Sel ect Query sel ectl = new Sel ect Query(Painting.class);
Li st paintingsl = context.perfornfuery(selectl);

I NFO SELECT t0. GALLERY_ID, t0.ARTIST_ID, t0.NAME, tO0.1D FROM PAINTING t0
INFO === returned 2 rows. - took 18 ns.

» Select paintings that start with "gi", ignoring case:

Expression qualifier2 = ExpressionFactory.|ikel gnoreCaseExp(

Pai nti ng. NAME_PROPERTY,

"gi%);
Sel ect Query sel ect2 = new Sel ect Query(Painting.class, qualifier2);
Li st paintings2 = context.perfornQuery(sel ect?2);

I NFO SELECT t0. GALLERY_ID, t0.NAME, t0. ARTIST_ID, t0.1D FROM PAI NTI NG t 0 WHERE UPPER(t 0. NAVE) LI KE UPPER(?)
[bind: 1->NAME:'Qgi %] - prepared in 6 ns.
INFO. === returned 1 row. - took 18 ns.

o Select all paintings done by artists who were born more than a 100 years ago (demonstrating using
Expression.fromString(..) instead of ExpressionFactory):

Cal endar ¢ = new GregorianCal endar () ;
c.set(c.get(Cal endar. YEAR) - 100, 0, 1, 0, O, 0);

Expression qualifier3 = Expression.fronfString("artist.dateOfBirth < $date");

qualifier3 = qualifier3.expWthParaneters(Collections.singletonVap("date", c.getTinme()));
Sel ect Query sel ect3 = new Sel ect Query(Pai nting.class, qualifier3);

Li st paintings3 = context. perfornQuery(sel ect3);

I NFO SELECT t0. GALLERY_ID, t0.NAME, t0.ARTIST ID, t0.1D FROM PAINTING t0 JON ARTIST t1 ON (t0.ARTIST_ID = t1.1
WHERE t 1. DATE_OF_BIRTH < ? [bind: 1->DATE_OF_BI RTH:' 1911- 01- 01 00: 00: 00.493'] - prepared in 7 ps.
INFO === returned 2 rows. - took 25 ns.

v.3.1 23
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This chapter explains how to model relationship delete rules and how to delete individual objects aswell as sets
of objects. Also demonstrated the use of Cayenne classto run aquery.

8.1. Setting Up Delete Rules

Before we discuss the API for object deletion, lets go back to CayenneModeler and set up some delete rules.
Doing thisis optional but will simplify correct handling of the abjects related to deleted objects.

Inthe Modeler goto "Artist" ObjEntity, "Relationships' tab and select "Cascade" for the "paintings' relationship
deleterule:

Ao * - CayenneModeler - (Users/dzmitry/tutorial/src/main/resources/cayenne-project.xml
Cle[@] (=] [+<[E[al (¢ o] [@E [e][e]A][E]2] Search:
8 project ["Entity = Attributes - Relationships | Callbacks = Listeners |

v o datamap

omm | |S[Bl0) %] [+l

@ Gallery MName ¥ Target Semantics Delete Rule | Used for Locking
@ Painting iﬁ: Painting Cascade =

[ ARTIST

] GALLERY

I PAINTING |,

» [ datanode

Repeat this step for other relationships:

e For Gallery set "paintings' relationship to be "Nullify", as a painting can exist without being displayed in a
galery.

 For Painting et both relationships rules to "Nullify".

Now save the mapping, and refresh the project in Eclispe.

8.2. Deleting Objects

While deleting objects is possible via SQL, qualifying a delete on one or more 1Ds, a more common way in
Cayenne (or ORM in general) isto get ahold of the object first, and then delete it viathe context. Let's use utility
class Cayenneto find an artist:
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Expression qualifier = ExpressionFactory. matchExp(Artist. NAVE_PROPERTY, "Pablo Picasso");
Sel ect Query sel ect = new Sel ect Query(Artist.class, qualifier);
Artist picasso = (Artist) Cayenne.object For Query(context, select);

Now let's delete the artist:

if (picasso != null) {
cont ext . del et eQoj ect (pi casso);
cont ext. conmi t Changes() ;

Since we set up "Cascade" delete rule for the Artist.paintings rel ationships, Cayenne will automatically delete all

paintings of this artist. So when your run the app you'll see this output:

I NFO SELECT t0. DATE_OF BIRTH, t0. NAME, tO0.|D FROM ARTI ST tO
VWHERE t 0. NAME = ? [bind: 1->NAME:' Pabl o Picasso'] - prepared in 6 ns.

INFO === returned 1 row. - took 18 ns.

I NFO. +++ transaction conm tted.

INFO. --- transaction started.

I NFO DELETE FROM PAI NTI NG WHERE ID = ?

INFO [batch bind: 1->ID: 200]

INFO [batch bind: 1->ID: 201]

I NFO === updated 2 rows.

| NFO DELETE FROM ARTI ST WHERE ID = ?

INFO [batch bind: 1->ID: 200]

I NFO === updated 1 row.

I NFO. +++ transaction commtted.
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Chapter 9. Converting to Web Application

This chapter shows how to work with Cayenne in aweb application.

9.1. Converting Tutorial to a Web Application

The web part of the web application tutorial is done in JSP, which is the least common denominator of the Java
web technologies, and isintentionally simplistic from the Ul perspective, to concentrate on Cayenne integration
aspect, rather than the interface. A typical Cayenne web application works like this;

« Cayenne configuiration is loaded when an application context is started, using a special servlet filter.

« User requestsareintercepted by thefilter, and the DataContext is bound to the request thread, so the application
can accessit easily from anywhere.

« The same DataContext instance is reused within a single user session; different sessions use different
DataContexts (and therefore different sets of objects). The context can be scoped differently depending on the
app specifics. For the tutorial we'll be using a session-scoped context.

o let's convert the tutorial that we created to aweb application:
e In Eclipse under "tutorial" project folder create a new folder "src/main/webapp/WEB-INF".

* Under "WEB-INF" create anew file "web.xml" (a standard web app descriptor):
web.xml

<?xm version="1.0" encodi ng="utf-8"?>
<! DOCTYPE web- app
PUBLIC "-//Sun M crosystens, Inc.//DTD Wb Application 2.3//EN'
"“http://java. sun. coni dt d/ web-app_2_3. dtd">
<web- app>
<di spl ay- nane>Cayenne Tut ori al </ di spl ay- name>

<l-- This filter bootstraps ServerRuntinme and then provides each request thread
with a session-bound DataContext. Note that the name of the filter is inportant,
as it points it to the right named configuration file.
-->
<filter>
<filter-nane>cayenne-project</filter-nanme>
<filter-class>org. apache. cayenne. confi guration. web. CayenneFilter</filter-class>
</filter>
<filter-mppi ng>
<filter-nane>cayenne-project</filter-nanme>
<url-pattern>/*</url-pattern>
</filter-mppi ng>
<wel conme-file-list>
<wel conme-fil e>i ndex. j sp</wel cone-fil e>
</wel come-file-list>
</ web- app>
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« Createthe artist browser page src/main/webapp/index.jsp file with the following contents:
webapp/index.jsp

<%@ page | anguage="j ava" content Type="text/htm" %
<%@ page i nport="org. exanpl e. cayenne. persi stent.*" %
<%@ page i nport="org. apache. cayenne. *" %

<%@ page i nport="org. apache. cayenne. query. *" %

<% page i nport="org. apache. cayenne. exp.*" %

<%@ page inport="java.util.*" %

<%
Sel ect Query query = new Sel ect Query(Artist.class);
guery. addOrdering(Artist. NAVME_PROPERTY, Sort O der. ASCENDI NG ;
Obj ect Cont ext context = BaseContext. get ThreadObj ect Cont ext ();
List<Artist> artists = context.performuery(query);
%>
<htm >
<head>
<title>Main</title>
</ head>
<body>
<h2>Arti sts: </ h2>
<% if(artists.isEmty()) {%
<p>No artists found</p>
<%} else {
for(Artist a : artists) {
%>
<p><a href="detail.jsp?i d=<%Cayenne. i nt PKFor Obj ect (a) %" > <%a. get Nane() % </ a></p>
<%
}
} %
<hr >
<p><a href="detail.jsp">Create new artist...</a></p>
</ body>
</htm >

« Createthe artist editor page src/main/webapp/detail .jsp with the following content:
webapp/detail.jsp

<% page | anguage="j ava" content Type="text/htm" %
<%@ page i nport="org. exanpl e. cayenne. persi stent.*" %
<%@ page i nport="org. apache. cayenne. *" %

<%@ page inport="java.util.*" %

<%@ page i nport="java.text.*" %

<%
hj ect Cont ext cont ext = BaseCont ext . get Thr eadObj ect Cont ext () ;

String id = request. getParanmeter("id");

// find artist for id
Artist artist = null;
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if(id!=null & id.trim().length() > 0) {
artist = Cayenne. obj ect For PK(context, Artist.class, Integer.parselnt(id));

i f("POST". equal s(request.get Method())) {
/1 if noidis saved in the hidden field, we are dealing with
/! create new artist request
if(artist == null) {
artist = context.newlbject(Artist.class);

/1 note that in a real application we would so donme validation ...
/1 here we just hope the input is correct

artist.set Nane(request. get Paraneter ("nanme"));
artist.setDateOfBirthString(request.getParaneter("dateCdBirth"));

cont ext. conm t Changes() ;

response. sendRedi rect ("i ndex. j sp");

}
if(artist == null) {
/] create transient artist for the formresponse rendering
artist = new Artist();
}
String nane = artist.getName() == null 2 "" : artist.getNanme();
String dob = artist.getDateO'Birth() == null
? "" : new Sinpl eDat eFor mat ("yyyyMwid").format (artist.getDateOf Birth());
%>
<htm >
<head>
<title>Artist Details</title>
</ head>
<body>
<h2>Artists Detail s</h2>
<formname="Edit Artist" action="detail.jsp" nethod="POST">
<i nput type="hidden" name="id" value="<% id !=null ?2id: "" %" />
<tabl e border="0">
<tr>
<t d>Nane: </t d>
<td><input type="text" name="name" val ue="<% name %"/></td>
</tr>
<tr>
<td>Date of Birth (yyyymMwd):</td>
<td><input type="text" name="dateO'Birth" val ue="<% dob %"/></td>
</tr>
<tr>
<td></td>
<td align="right"><input type="submt" val ue="Save" /></td>
</tr>
</tabl e>
</ forne
</ body>
</htm >
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9.2. Running Web Application

To run the web application we'll use "maven-jetty-plugin*. To activateit, let's add the following piece of code to
the "pom.xml" file, following the "dependencies’ section and save the POM:

<bui | d>
<pl ugi ns>
<pl ugi n>
<groupl d>or g. nort bay. j etty</ groupl d>
<artifactld>maven-jetty-plugin</artifactld>
<versi on>6. 1. 22</ ver si on>
</ pl ugi n>
</ pl ugi ns>
</ bui | d>

¢ Goto "Run > Run Configurations..." menu, select "Maven Build", right click and select "New"

» Makesureyou fill "Name", "Base directory” and "Goals" fields as shown on the screenshot:

8.0 Run Configurations
Create, manage, and run configurations ;—;
= 1
TE X | E Name:  cayenne-tutorial
] type filter text D Main =i JRE Qéh Refresh | g Environment | =] Common
f Apache Tomeat Base directory:

4 Eclipse Application
[£4 Eclipse Data Tools
E Ceneric Server (" Browse Workspace... ) ( Browse File System... Y ( variables... )
E Ceneric Server(External Launch)

E HTTP Preview

S{workspace_loc:/tutorial}

[ select.. )

d : Goals: | jetty:
[ J2EE Preview oals:  ljetty:run —
0] Java Applet Profiles:
[T Java Application
TL:JUmt [ Offline ] Update Snapshots
fl}.JUmt Plug-in Test [ Debug Output [ Skip Tests  [_| Non-recursive
m2 Maven Build ] Resolve Workspace artifacts
m2 cayenne-tutorial .
& OSGi Framework Parameter Name Value aAdd )
JuyTask Context Test
> X5L Edit...
Remove
Maven Runtime: | Embedded (3.0-SNAPSHOT/0.12.1.20110112-1712) ﬂ ( Configure... b
Apply Revert

Filter matched 16 of 16 itemns

@) ( Close Y E Run 3

e Click "Apply" and "Run". On the first execution it may take a few minutes for Jetty plugin to download all
dependencies, but eventually you'll see the logs like this:
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[INFOQ Scanning for projects...

[ I NFO

IO I e
[INFQ Building tutorial 0.0.1- SNAPSHOT

O I e

[INFO Configuring Jetty for project: tutorial

[INFO Webapp source directory = /.../tutorial/src/ min/webapp
[INFO Rel oad Mechanic: automatic

[INFO Classes = /.../tutorial/target/classes

[INFO Context path = /tutorial

[INFO Tnp directory = determned at runtinme

[INFOQ Web defaults = org/nortbay/jetty/ webapp/ webdef aul t. xm
[INFO Wb overrides = none

[INFO web.xm file =/.../tutorial/src/min/webapp/WEB-| N~/ web. xmn
[INFO Webapp directory = /.../tutorial/src/ min/webapp

[INFQ Starting jetty 6.1.22 ...

INFO :jetty-6.1.22

INFO : No Transacti on manager found - if your webapp requires one, please configure one.
INFO : Started Sel ect Channel Connect or @. 0. 0. 0: 8080

[INFO Started Jetty Server

e S0 the Jetty container just started.

» Now go to http://localhost: 8080/tutorial/ URL. Y ou should see "No artists found message” in the web browser

and the following output in the Eclipse console:

I NFO. Loadi ng XM. configuration resource fromfile:/.../tutorial/target/classes/cayenne-
I NFO. | oadi ng user nane and password.
I NFO Created connection pool: jdbc: derby: menory:testdb;create=true

Driver class: org.apache. derby.jdbc. EnbeddedDri ver

M n. connections in the pool: 1

Max. connections in the pool: 1
I NFO Openi ng connection: jdbc: derby: menory: testdb; create=true

Logi n: nul |

Password: ***xxxx
I NFO. +++ Connecti ng: SUCCESS.
INFO Detected and installed adapter: org. apache. cayenne. dba. der by. Der byAdapt er
INFO. --- transaction started.
INFO No schena detected, will create napped tables
I NFO CREATE TABLE GALLERY (1D I NTEGER NOT NULL, NAME VARCHAR (200), PRI MARY KEY (ID))
I NFO CREATE TABLE ARTI ST (DATE_OF BI RTH DATE, | D I NTEGER NOT NULL, NAME VARCHAR (200),
I NFO CREATE TABLE PAI NTI NG (ARTI ST_|I D | NTEGER, GALLERY_ID I NTECER, |D | NTEGER NOT NULL,

NAVE VARCHAR (200), PRI MARY KEY (ID))
I NFO ALTER TABLE PAI NTI NG ADD FOREI GN KEY (ARTI ST_I D) REFERENCES ARTI ST (I D)
I NFO ALTER TABLE PAI NTI NG ADD FORElI GN KEY ( GALLERY_| D) REFERENCES GALLERY (I D)
I NFO CREATE TABLE AUTO_PK_SUPPORT (
TABLE _NAME CHAR(100) NOT NULL, NEXT_ID BIG NT NOT NULL, PRI MARY KEY( TABLE_NAME))

I NFO DELETE FROM AUTO PK_SUPPORT WHERE TABLE_NAME I N (' ARTI ST', ' GALLERY', ' PAINTING )
INFO | NSERT | NTO AUTO PK_SUPPORT ( TABLE_NAME, NEXT_I D) VALUES (' ARTI ST', 200)
I NFO | NSERT | NTO AUTO PK_SUPPORT ( TABLE_NAME, NEXT_I D) VALUES (' GALLERY', 200)
I NFO. | NSERT | NTO AUTO PK_SUPPORT (TABLE NAME, NEXT | D) VALUES (' PAINTING, 200)

I NFO SELECT t 0. DATE_OF_BI RTH, t0. NAME, tO0.|D FROM ARTI ST t0 ORDER BY t0. NAME - prepared in 43 ns.

INFO === returned O rows. - took 56 ns.
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INFO +++ transaction comitted.

¢ You can click on "Create new artist” link to create artists. Existing artists can be edited by clicking on their
name:

5 O C

Il () % ) (&) (B nhup://127.0.0.1:8080/tutorial findex.jsp

Malevich

Picasso

Create new artist...

Y ou are done with the tutorial!
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